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Frontispiece. Japan Marine Science 
and Technology Center (JAMSTEC) 
submersible Shinkai 6500 (Dive 351) 
bottom photograph of the megafaunal 
community at Ocean Drilling Program 
(ODP) Site 1200 on the summit of 
South Chamorro Seamount, a 
serpentine mud volcano on the 
southern Mariana forearc. The 
submersible’s manipulator arm is 
holding a push core to sample a small 
carbonate chimney (white mound 
immediately below core tube) at the 
edge of a narrow vent fissure in the 
serpentine muds. Mussels, likely of the 
genus Bathymodiolus, galatheid crabs, 
tube worms, crinoids, and gastropods 

are the surface manifestation of the 
biological community supported by 
the slab-derived fluids emanating from 
this spring (Fryer and Mottl, 1997). A 
microbial community recovered in 
Hole 1200D, near this location, persists 

to 20 meters below seafloor and provides the base of the food chain supporting the surface megafaunal community.

Reference
Fryer, P., and Mottl, M., 1997. Shinkai 6500 investigations of a resurgent mud volcano on the southeastern Mariana forarc. JAMSTEC J. Deep Sea Res.,

13:103–114.
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Reference to the whole or to part of this volume should be made as follows: 

Print citation for Chapter 1:
Shipboard Scientific Party, 2002. Leg 195 summary. In Salisbury, M.H., Shinohara, M., Richter, C., et 
al., Proc. ODP, Init. Repts., 195: College Station TX (Ocean Drilling Program), 1–63.

CD-ROM volume citation:
Salisbury, M.H., Shinohara, M., Richter, C., et al., 2002. Proc. ODP, Init. Repts., 195 [CD-ROM]. 
Available from: Ocean Drilling Program, Texas A&M University, College Station TX 77845-9547, USA.

CD-ROM chapter citation:
Shipboard Scientific Party, 2002. Site 1200. In Salisbury, M.H., Shinohara, M., Richter, C., et al., Proc. 
ODP, Init. Repts., 195, 1–173 [CD-ROM]. Available from: Ocean Drilling Program, Texas A&M 
University, College Station TX 77845-9547, USA.

This volume also appears on the World Wide Web. See www-odp.tamu.edu/publications for Web 
citation formats.

http://www-odp.tamu.edu/publications
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Effective publication dates of ODP Proceedings

According to the International Code of Zoological Nomenclature, the date of publication of a work 
and of a contained name or statement affecting nomenclature is the date on which the publication 
was mailed to subscribers, placed on sale, or when the whole edition is distributed free of charge, 
mailed to institutions and individuals to whom free copies are distributed. The mailing date, not the 
printing date, is the correct one.
The printing date of this volume: July 2002

The mailing dates of recent Proceedings of the Ocean Drilling Program:
Volume 193 (Initial Reports): January 2002
Volume 194 (Initial Reports): March 2002
Volume 196 (Initial Reports): May 2002
Volume 172 (Scientific Results): September 2001
Volume 173 (Scientific Results): August 2001
Volume 175 (Scientific Results): March 2002

Copies of this publication may be obtained from Publications Distribution Center, Ocean Drilling 
Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-9547, USA. See the 
ODP publication list at www-odp.tamu.edu/publications or contact ODP for prices and ordering 
information. Orders for copies require advance payment.

ISSN
Book: 0884-5883; CD-ROM: 1096-2522; World Wide Web: 1096-2158
Library of Congress 87-642-462

http://www-odp.tamu.edu/publications
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PUBLISHER’S NOTES
This volume also appears on the World Wide Web. Any scientific corrections, revisions, or additions will 
be noted in the chapter (see “Chapter Notes”) at www-odp.tamu.edu/publications.

This publication was prepared by the Ocean Drilling Program, Texas A&M University, as an account of 

work performed under the international Ocean Drilling Program, which is managed by Joint 
Oceanographic Institutions, Inc., under contract with the National Science Foundation. Funding for 
the program was provided by the following agencies at the time of this cruise:

Australia/Canada/Chinese Taipei/Korea Consortium for Ocean Drilling: Department of Primary Industries and 
Energy (Australia), Natural Resources Canada, National Taiwan University in Taipei, and Korean Institute for 
Geology, Mining and Minerals

Deutsche Forschungsgemeinschaft (Federal Republic of Germany)

European Science Foundation Consortium for Ocean Drilling (Belgium, Denmark, Finland, Iceland, Ireland, Italy, 
The Netherlands, Norway, Portugal, Spain, Sweden, and Switzerland)

Institut National des Sciences de l’Univers–Centre National de la Recherche Scientifique (INSU-CNRS) (France)

Marine High-Technology Bureau of the State Science and Technology Commission of the People’s Republic of 
China

National Science Foundation (United States)

Natural Environment Research Council (United Kingdom)

University of Tokyo, Ocean Research Institute (Japan)

http://www-odp.tamu.edu/publications
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Any opinions, findings, and conclusions or recommendations expressed in this publication are those of 

the author(s) and do not necessarily reflect the views of the National Science Foundation, the 
participating agencies, Joint Oceanographic Institutions, Inc., Texas A&M University, or Texas A&M 
Research Foundation.

Abbreviations for names of organizations and publications in ODP reference lists follow the style given 
in Chemical Abstracts Service Source Index (published by American Chemical Society).

The bulk of the shipboard-collected data from this leg is available on the World Wide Web and is 
accessible at www-odp.tamu.edu/database. If you cannot access this site or need additional data, 
please contact the ODP Data Librarian, Ocean Drilling Program, Texas A&M University, College Station 
TX 77845-9547, USA. E-mail: database@odpemail.tamu.edu.

A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available on the 
volume CD-ROM in PDF format. These maps were produced using Generic Mapping Tools (GMT) of 
Paul Wessel and Walter H.F. Smith (gmt.soest.hawaii.edu).

Cover photograph, by Co-Chief Scientist Masanao Shinohara, is of the battery platform that was 
installed at Site 1202.

http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
http://gmt.soest.hawaii.edu
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FOREWORD

BY JOINT OCEANOGRAPHIC INSTITUTIONS, INC.

This volume presents scientific and engineering results from the Ocean Drilling Program (ODP). These results 
address the scientific and technical goals of the program, which are focused on the study of the dynamics of 
Earth’s interior and environment, the evolution of oceanic crust, and the fluctuations of climate. In addition, 
study of the Earth’s deep biosphere is an emergent research objective.

ODP, an international partnership of scientists and research institutions from 22 countries, operates the drillship 
JOIDES Resolution. This state-of-the-art research vessel contains eight levels of laboratories and other scientific 
facilities required for carrying out the program’s objectives.
The management of ODP involves a partnership of scientists and governments. International oversight and 
coordination are provided by the ODP Council, which is made up of representatives from the member 
countries. Overall scientific and management guidance is provided by representatives from the Joint 
Oceanographic Institutions for Deep Earth Sampling (JOIDES).

Joint Oceanographic Institutions, Inc. (JOI), a nonprofit consortium of 16 U.S. oceanographic institutions, serves 
as the National Science Foundation’s prime contractor for ODP. JOI implements scientific objectives, plans, and 
recommendations of the JOIDES committees through major subcontracts to Texas A&M University (TAMU) for 
science operations and to Lamont-Doherty Earth Observatory (LDEO) of Columbia University for geochemical 
and geophysical well-logging services.

JOI, TAMU, and LDEO have worked together successfully for many years to manage the Ocean Drilling 
Program. We look forward to many exciting discoveries and continued international collaboration as we further 
our scientific mission, especially the planning for the future of ocean drilling beyond 2003.

Steven R. Bohlen
President of the Joint Oceanographic Institutions and Executive Director of the Ocean Drilling Programs
Washington, D.C.
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Tel: (703) 306-1581; Fax: (703) 306-0390
Web site: www.nsf.gov
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*At time of publication. See Publisher’s Notes, p. 6, for list of funding agencies at time of cruise. For an up-to-date list of
current member organizations and office contact information, see the ODP Web site: www.oceandrilling.org.

http://www.nsf.gov/
http://www.oceandrilling.org/
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Geology, Mining and Minerals

European Science Foundation Consortium for 
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Iceland, Ireland, Italy, The Netherlands, Norway, 

OCEAN DRILLING PROGRAM (ODP)

Web site: www.oceandrilling.org

ODP SCIENCE ADVISORY STRUCTURE 
(JOIDES)

JOIDES Office
University of Miami—RSMAS
Portugal, Spain, Sweden, and Switzerland)

Federal Republic of Germany, Bundesanstalt für 
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France, Institut National des Sciences de 
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People’s Republic of China, Marine High-
Technology Bureau of the State Science and 
Technology Commission of the People’s 
Republic of China

United Kingdom, Natural Environment Research 
Council 
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Miami FL 33149, USA
Tel: (305) 361-4668; Fax: (305) 361-4632
E-mail: joides@rsmas.miami.edu
Web site: joides.rsmas.miami.edu

http://www.oceandrilling.org/
mailto:joides@rsmas.miami.edu
http://joides.rsmas.miami.edu
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ODP PROGRAM MANAGER

Joint Oceanographic Institutions, Inc.
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ODP LOGGING SERVICES OPERATOR

Borehole Research Group
Lamont-Doherty Earth Observatory
Washington DC 20036-2102, USA
Tel: (202) 232-3900; Fax: (202) 462-8754
E-mail: joi@joiscience.org
Web site: www.joiscience.org

ODP SCIENCE OPERATOR

Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station TX 77845-9547, USA
Tel: (979) 845-2673; Fax: (979) 845-4857
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Web site: www-odp.tamu.edu

Columbia University
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Palisades NY 10964, USA
Tel: (845) 365-8341; Fax: (845) 365-3182
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Web site: www.ldeo.columbia.edu/BRG/ODP
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Lamont-Doherty Earth Observatory
Columbia University
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Palisades NY 10964, USA
Tel: (845) 365-8542; Fax: (845) 365-8159
E-mail: odp@ldeo.columbia.edu
Web site: www.ldeo.columbia.edu/databank

mailto:joi@joiscience.org
http://www.joiscience.org
mailto:odp@odpemail.tamu.edu
http://www-odp.tamu.edu/
mailto:borehole@ldeo.columbia.edu
http://www.ldeo.columbia.edu/BRG/ODP
mailto:odp@ldeo.columbia.edu
http://www.ldeo.columbia.edu/databank


12

LEG 195 PARTICIPANTS*

SHIPBOARD SCIENTIFIC PARTY

Matthew H. Salisbury
Co-Chief Scientist
Geological Survey of Canada
Bedford Institute of Oceanography
PO Box 1006
Dartmouth NS B2Y 4A2
Canada

Department of Earth Sciences
Dalhousie University

Carl Richter
Staff Scientist/Paleomagnetist
Ocean Drilling Program
Texas A&M University
1000 Discovery Drive
College Station TX 77845-9547
USA
richter@odpemail.tamu.edu

Eiichiro Araki

Halifax NS B3H 3J5
Canada
matts@agc.bio.ns.ca

Masanao Shinohara
Co-Chief Scientist
Earthquake Research Institute
University of Tokyo
Yayoi 1-1-1, Bunkyo-ku
Tokyo 113-0032
Japan
mshino@eri.u-tokyo.ac.jp

Seismologist
Deep Sea Research Department
Japan Marine Science and Technology Center
2-15 Natsushima-cho
Yokosuka, Kanagawa 237-0061
Japan
araki@jamstec.go.jp

*Addresses at time of cruise, except where updated by the leg participants before publication.
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mailto:araki@jamstec.go.jp
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CD-ROM CONTENTS: CORE DESCRIPTIONS
Visual core descriptions (VCDs); smear slide, thin section, and sedimentary thin section data tables; 
and digital core images are included in this section. ASCII versions of the smear slide and sedimentary 
thin section data tables are also available (see “ASCII Tables”).

Site 1200

Visual Core Descriptions · Smear Slides · Thin Sections 

Site 1201

Visual Core Descriptions · Smear Slides · Thin Sections

Site 1202

Visual Core Descriptions · Smear Slides 
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CD-ROM CONTENTS: ASCII TABLES
This CD-ROM contains ASCII versions of the structural geology data table and of the smear slide data 
tables and sedimentary thin section data table presented under “Core Descriptions.” A complete 
listing of the ASCII tables can be found listed below. 

You can access these data directly from the PDF files. Depending on your computer platform, the 
following information applies.

PC COMPUTERS
By default, double-clicking on a filename with a .TXT extension will launch the Notepad application. 

You can configure your computer’s operating system so that files on this CD with .TXT extensions 
automatically open in other software, such as Microsoft Excel. Follow these steps from the pull-down 
menu: Windows 95 and NT operating systems: View > Options > File Types; and Windows 98, 2000, 
ME, and XP systems: View > Folder Options > File Types.

MACINTOSH COMPUTERS
All table files with .TXT extensions will automatically open into Excel. If you do not have Excel installed 
on your computer, you may view these files through other spreadsheet or text-editor programs. Open 
the application of your choice, select File > Open, and open the ASCII file.

UNIX COMPUTERS
You can open files with .TXT extensions in any text editor or spreadsheet program, but not directly 
from PDF files.

Chapter 3 Smear slide data tables Thin section data tables 
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Chapter 3
Appendix: Dimensional Characteristics of Serpentine Clasts, Hole 1200A.

Smear Slide Data Tables
Site 1200 smear slide table.
Site 1201 smear slide table.
Site 1202 smear slide table.

Thin Section Data Tables
Site 1201 sedimentary thin section table.
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CD-ROM CONTENTS: DRILLING LOCATION MAPS
A site map showing the drilling locations for this leg and maps showing the drilling locations of all 
Ocean Drilling Program (ODP) and Deep Sea Drilling Project (DSDP) drilling sites are available in PDF 
format.

ODP Leg 195 Site Map 

ODP Map (Legs 100–195)

DSDP Map (Legs 1–96)
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RELATED LEG DATA

DOWNHOLE LOGGING AND CORE DATA 

A second CD-ROM is included with this volume. The “Log and Core Data” CD contains Leg 195 
depth-shifted and processed downhole logging data and shipboard core logging data (color 
reflectance, gamma ray attenuation bulk density, magnetic susceptibility, moisture and density, and 
natural gamma radiation). The downhole logging data are provided by the Borehole Research Group 
at the Lamont-Doherty Earth Observatory, Wireline Logging Operator for ODP.

Most of the logging and core data included on this CD are available on the World Wide Web at 
www.ldeo.columbia.edu/BRG/ODP. If you cannot access this site or want to order the CD, please 

contact the ODP Logging Services Operator at the Lamont-Doherty Earth Observatory, Columbia 
University, Route 9W, Palisades NY 10964, USA; Tel: (845) 365-8341; Fax: (845) 365-3182; E-mail: 
borehole@ldeo.columbia.edu.

The majority of the core data on the CD are available on the Web at www-odp.tamu.edu/database. 
If you cannot access the ODP database or need additional data, please contact: ODP Data Librarian, 
Ocean Drilling Program, Texas A&M University, 1000 Discovery Drive, College Station TX 77845-
9547, USA; Tel: (979) 845-8495; Fax: (979) 458-1617; E-mail: database@odpemail.tamu.edu.

COMPILED ELECTRONIC INDEX
The Compiled Electronic Index of the Proceedings of the Ocean Drilling Program included on the volume 
CD-ROM contains individual indexes of Volumes 101–173, 174B, and 175. The indexes are contained 
in the directory titled ODPINDEX and are named ###NDX.PDF (### = the leg number). These indexes 
can be searched individually or collectively.

http://www.ldeo.columbia.edu/BRG/ODP
mailto:borehole@ldeo.columbia.edu
http://www-odp.tamu.edu/database
mailto:database@odpemail.tamu.edu
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MAC
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